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The RCC Pilotage Foundation is grateful to Pete Hill for allowing us to publish his notes, arising from his 
cruise up the coast from Cape Town to Walvis Bay, Nambia.  This adds to his other contributions to providing 
pilotage information in the South Atlantic all of which form part of a family of publications within the RCC 
Pilotage Foundation.  Much of this is free to download.  All may be found on www.rccpf.org.uk

Caution
These notes have been prepared by the author on the basis of the information obtained in the course 
of a visit to the areas described.  In particular, soundings shown reflect the route taken by the author 
and the absence of soundings does not indicate that depths are necessarily safe.  The notes are in no 
way comprehensive and refer only to the conditions encountered at the time of the visit.  Any plans are 
simply sketches and do not represent the results of a survey of the places referred to.  They should be 
used with extreme caution.  The RCC Pilotage Foundation and the authors has published these notes in 
the hope that they may be of some help to mariners but the safety of a vessel depends ultimately on 
the judgement of the skipper who should access all information, published or unpublished.

To the extent permitted by law, the RCC Pilotage Foundation and the authors do not accept 
liability for any loss and/or damage howsoever caused that may arise from reliance on information 
obtained in these pages.

Plans pages 3 and 5:	© RCC Pilotage Foundation 2010
Remaining Plans:	 © Crown Copyright and/or database rights.  Reproduction by 				  

			   permission of 	 Controller of Her Majesty’s Office and the UK 				  
	   		  Hydrographic Office (www.ukho.gov.uk) under Licence Agreement 			 
			   HO 2290/1001128/01 dated 15 February 2010

PLANS ARE NOT TO BE USED FOR NAVIGATION
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This is part of a series of Books and Web Pilots by the RCC Pilotage Foundation, a voluntary organization run 
by yachtsmen for yachtsmen.  Contributions are always welcome.  This document covers ports and harbours 
on mainland SW Africa.  It adds to the information, including Cape Town, available in our book South Atlantic 
Circuit.  A companion e publication South Atlantic Islands covers the four islands shown below.    

Full details of the Pilotage Foundations publications may be found on www.rccpf.org.uk.  These includes 
the free to download Passage Planning Guide SA1 which covers the passages from Cape Town to Brazil and 
the Caribbean

		     For an on-line ocean overview image click

SOUTH WEST AFRICA
© RCC Pilotage Foundation 2010

PETE HILL

http://maps.google.co.uk/maps/ms?hl=en&ie=UTF8&msa=0&ll=-24.367114,4.042969&spn=39.390625,56.337891&t=h&z=4&msid=111485959450724205753.000480f6eaac2e082741d
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WEST COAST OF SOUTHERN AFRICA

Introduction
These cruising notes cover the west coast of South Africa north of Cape Town and the coast of Namibia 
from Luderitz to Walvis Bay. It is hoped that they will be helpful to fellow mariners, but please bear in mind 
that they have been compiled from a cruise up this coast in 2007/8 and in no way represent detailed local 
knowledge. The sketch charts are just that and should not be used for navigation, if forced to be used as 
such then exercise extreme caution. Every effort has been made to be accurate. Please report any errors or 
changes that have occurred to the RCC Pilotage Foundation so that this information can be kept up to date.

South Africa
Time:  GMT +2

Language:  There are 11 official languages but English is the main spoken one, although on the west coast 
Afrikans is very common.

Immigration
Visitors are given a 3 month visa on arrival. This can be extended for a further 3 months at the Department 
of Home Affairs at a cost of 120 Rand (2007). Application for an extension should be made a least 1 month 
before the old one expires and needs to be accompanied by proof of sufficient funds (a recent bank statement 
is acceptable), a letter from the yacht club/marina where you are staying stating that you owe no money and 
a letter giving the reasons for needing an extension. No further extensions will be issued and you will need to 
leave the country and re-enter to get a new visa (if planning to do this check on the latest regulations as just 
visiting adjacent countries may not be sufficient to be given a new visa)

Note that Saldanha no longer has an immigration officer there, the nearest being Cape Town.

Customs
On arrival in South Africa Customs will grant a one year stay free of import duties. Officially you need to clear 
into and out of each Customs area in the country. Not all Customs officers bother with this but Saldanha 
Customs is very strict and yachts have been fined on this point.

VAT
In theory a foreign yacht can reclaim the VAT paid on non consumable items purchased in the last 3 months 
before leaving. This involves producing VAT invoices made out in your name and presenting them to Customs 
who will authorise them and send them on to Pretoria to be processed. I have yet to hear of any one actually 
receiving a refund. Some suppliers (but not usually shops) will sell VAT free to ships in transit on production 
of your vessels registration papers, it is always worth asking but make sure you do so before the invoice is 
made out. 

Security
South Africa has a bad reputation for crime, most of which is concentrated in the big cities and townships. 
Many white middle class people have an excessive concern about crime and they are often only too happy to 
tell you horror stories and warn you off venturing anywhere. Use your own judgement to decide if any advise 
given is reasonable or just paranoid. Be ‘street wise’ and you are unlikely to have any problems.  

http://maps.google.co.uk/maps/ms?hl=en&ie=UTF8&msa=0&ll=-24.367114,4.042969&spn=39.390625,56.337891&t=h&z=4&msid=111485959450724205753.000480f6eaac2e082741d
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Namibia
Time:  GMT+1 (winter), GMT+2 (summer)

Language:  English is the offical language but in Luderitz and Walvis Bay Afrikans is very commonly used.

Immigration and Customs
On arrival a visa for 90 days will be issued, which can be renewed. Customs will grant a yacht a temporary 
import duty free.

Security
There is little crime in Namibia.   

This is an active file, click on the title or map for direct access to a port.  Click on 
a yellow pin to access Google Maps.  Place cursor over a photograph with a red 
border to expand it. Use the mark up tools to update your copy of the epilot.
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http://maps.google.co.uk/maps/ms?hl=en&ie=UTF8&msa=0&ll=-24.367114,4.042969&spn=39.390625,56.337891&t=h&z=4&msid=111485959450724205753.000480f6eaac2e082741d
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1.		  DASSEN ISLAND

House Bay          	 33   24.5’ S     18   05’ E          

Charts	 		  SAN 118A, 118B      BA 2091

Tides                        		  HW springs @ 10.30 approx.    height 1.4 metres
                                   	  	 HW neaps    @17.00  approx     height 0.5 metres 

Light                         		  Dassen Island light  fl (2) 30 sec 47 metres 26 nm Fog signal 15s
                                  		  33 26’S  18 05.3’ E (at the south end of the island)

Magnetic Variation		  23 deg.W (2009)                                

General
Dassen Island is a small isle lying 4.5 miles SW of Yzerfontein and 35 miles N of Cape Town. House bay is a 
delightful anchorage on the north side of the island providing shelter from all southerly winds. It is, however, 
wide open to the north. This makes a useful overnight anchorage on passage along the west coast but it is 
well worth a visit for it’s own sake. The whole island is a nature reserve with a resident warden, but landing is 
only allowed with a permit. Fishing boats frequently anchor here.

Approach
If approaching from the south, pass to the east of the island to avoid numerous reefs and rocks off the west 
coast. When entering the bay keep well clear of Die Blaasbalk, a drying rock.

From the north the approach is straightforward.

Anchorage
Anchor in about 4 metres NE of the jetty in sand, good holding. No facilities  

http://maps.google.co.uk/maps/ms?hl=en&ie=UTF8&msa=0&ll=-33.418475,18.085556&spn=0.03582,0.055017&t=h&z=14&msid=111485959450724205753.000480f6eaac2e082741d
http://maps.google.co.uk/maps/ms?hl=en&ie=UTF8&msa=0&ll=-33.418475,18.085556&spn=0.03582,0.055017&t=h&z=14&msid=111485959450724205753.000480f6eaac2e082741d
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Dassen Island Light from House				                    	 Wreck of Eastern Point House Bay

House Bay Jetty
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2.  	 SALDANHA BAY      33 03’ S     17 59’ E         
											            
Charts 	 		  SAN 118A, 1010,1011,1012   BA1232,1236

Tides             		 HW springs  @ 10.30 approx. height 1.4 metres
                          		  HW neaps    @ 17.00 approx.  height 0.5 metres

Lights                        	 North Head   Fl (3) 20s W 33 metres 23nm  33 03’S    17 54.7’E
                                  		  South Head  Fl (4) 30s W 34 metres 24nm   33 06.4’S 17 57.3’E

Magnetic variation   	23 deg.W (2009)                         

General
Saldanha Bay is a natural harbour 60 miles north of Cape Town with an iron ore terminal and a busy fishing 
fleet. At the north end of the bay is the small town of Saldanha and at the east side is the resort and marina 
of Club Mykonos, just north of the growing village of Langebaan. The whole south part of the bay, which is 
shallow, is the West Coast Nature Reserve.

Approach
From the south pass South Head and then go either side of Jutten Island, unless there is a strong onshore 
wind, in which case pass north of the island.

From the north pass between Malgas Island and Jutten Island.
Leading lights on a bearing of 056 deg. lead between Malgas Island and Jutten Island to the Lynch Point 

leading lights, on a bearing of 080 deg., which take you to the buoyed channel (continuing along this leading 
line will take you directly to Club Mykonos).

Saldanha bay is a busy port with a harbour control centre. Call them on VHF channel 16 or 14 before 
entering the bay and they will advise on traffic. The entrance is buoyed with ships having right of way. There 
is depth and room to stay outside the buoys alongside Marcus Island. Once past Marcus Island keep east of 
the numerous mussel farm rafts and follow the cardinal buoys into the inner harbour. 

http://maps.google.co.uk/maps/ms?hl=en&ie=UTF8&msa=0&ll=-33.042918,17.946167&spn=0.143897,0.22007&t=h&z=12&msid=111485959450724205753.000480f6eaac2e082741d
http://maps.google.co.uk/maps/ms?hl=en&ie=UTF8&msa=0&ll=-33.042918,17.946167&spn=0.143897,0.22007&t=h&z=12&msid=111485959450724205753.000480f6eaac2e082741d
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Formalities
Saldanha has customs clearance, but no immigration officer. Clearing in or out of South Africa can be 
accomplished here but it means getting to Cape Town to see immigration (see Transport). If arriving from 
another port in South Africa you must clear out of that port with customs and clear into Saldanha customs, 
yachts have been fined for failing to do this. The customs office is just inside the gates at the ore terminal. 
Contact the customs officer, Mr. Kuys (cell 082 4518 254) on arrival. If at Saldanha Bay Y. C. they may well be 
able to arrange a lift with one of the members, the other options are a taxi, mini bus (one to Vredenburg and 
another to the terminal) or a long walk.

Wind
The prevailing wind in the summer months is south to southeast and can blow strongly, particularly in the 
afternoons. The wind usually dies down overnight.

Saldanha Town
Saldanha is a small town at the north end of the bay with all the usual facilities.

Saldanha Bay Yacht Club
The club makes visitors very welcome. It is possible to anchor outside the moorings in 7 metres, but this is in 
the approach to one of the fish processing jetties, with fishing boats passing close by frequently. The yacht 
club recommends picking up one of their moorings. The floating pontoon is the dinghy dock and it is possible 
to go alongside for short stays to load or to take on water, electricity can be arranged.

The club offers visitors ten days free use of a mooring (if available) and the clubs facilities. There after they 
charge (2008) R15 a day for use of the clubs facilities and R3.50 a metre a day for a mooring. Facilities of the 
club include toilets, hot showers, large braai (bbq) area and the bar is open most evenings. The club is run by 
a manager, who is the person to see on arrival. 

Next to the clubhouse is a large concrete ramp where boats are hauled out on a trailer for maintenance. 
It may be possible for a visitor to use this or dry out, between tides, on the ramp (if the vessel can support 
herself).

Opposite the club entrance is the South African Naval Academy, which has a large nature reserve in its 
grounds. The public are welcome to use the various well-marked nature trails, ask at the gate for directions 
to the reserve.

Alternative Anchorages can be found at the west end of Hoedjiesbaai, off the beach and town, in the small 
boat harbour, NW of the harbour control tower and east of the control tower, clear of the mussel rafts.

Transport
A bus leaves Saldanha (by the BP garage) each morning at 5.30 and arrives in Cape Town at about 9.30. It 
returns from Cape Town at 1700. This bus stops at Malmesbury, if you need to renew your visa. This service 
is run by Elweida.com, telephone for up to date information and reservations.

Mini busses go frequently to Vredenburg during the day. Car hire is available in Vredenburg and will 
probably deliver a car to the yacht club. 

Club Mykonos
This is a resort, casino and marina. There are usually berths available for visitors. The boatyard here has a 
large travel lift and dry storage for yachts. Apart from restaurants and bars at the resort there are no facilities 
and it is several miles into Langebaan, the nearest shopping area. A large yacht might find the turning room 
in the marina restricted, particularly in strong southerly winds. It is possible to anchor south of the marina in 
3 metres.
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Langebaan
Langebaan is a small holiday town on the east side of the bay, with all basic shopping and a wide selection of 
restaurants.

Anchorages
The south part of the bay has numerous shoals and dangers and should only be visited with a detailed chart. 

Langebaan Yacht Club is at the south end of town and has a few moorings and it is possible to anchor 
outside these, but the current runs very strongly here at spring tides. The club makes visitors welcome.

It is also possible to anchor northwest of Skaap Island, which gives shelter from the southeast and is out 
of the worst of the tidal current.

Another anchorage is north of Perleman Point, at the mouth of Rietbaai. Make sure you anchor south of 
the line of buoys stretching SW/NE across the bay (this marks the limit of the special forces military area).

Within the West Coast National Park is the popular summer anchorage of Kraal Bay, where Frank Wightman 
lived for many years aboard Wylo. The bay is shallow and there are anchoring charges. 

Saldanha Yacht Club

Saldanha Yacht Club Moorings
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Fishing Jetty					                 Mussel farming

Inner Harbour

Iron Ore Terminal				                 South Head Light
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3.  	 ST. HELENA BAY      32 40 S     18 E         
											            
Charts 	 		  SAN 118A, 1008, 1009
Tides             		 HW springs @ 10.30 approx. height  1.4 metres
                                    	 HW neaps   @ 04.30 Approx. height   0.6 metres

Lights                        	 Cape St. Martin  sector 130-095 Fl 10s W 17meters 8nm 
                                 		  sector 095-130 Fl 10s R  “              “
                                     	32 42.9’S  17 55.2’E
                                    	 Stupneus Point Fl 3s W 10 metres 10nm  32 42.2S 17 58.9E 

Magnetic variation    	 23 deg.W (2009)                         

General
St. Helena is a large bay on the west coast 80 miles north of Cape Town. In the SE corner of the bay lie Sandy 
Point Harbour and further east the mouth of the Berg River, inside which lies Port Owen Marina.

Approach
From the south keep outside the 50-metre line to avoid Jim Crow rock, Britannia Reef and the North Blinder 
rock until past Stompnuespunt. Then turn east to enter the bay. It is possible to pass inshore of Britannia Reef 
and the North Blinder Rock, but should only be attempted with a large-scale chart and good visibility.   From 
the north the approach is straightforward.

Sandy Point Harbour       32 45.5S  18 01E
This harbour is used by fishing boats and is protected by a large breakwater giving good shelter from all but 
the east.

Anchor in the south of the harbour in 3 metres, off the sandy beach. Sand bottom with good holding. Land 
on the beach. The village has a few shops for basic needs and a petrol station. Excellent fish and chips from 
two shops in the harbour close to the wharf.

Sandy Point					                 Port Owen

http://maps.google.co.uk/maps/ms?hl=en&ie=UTF8&msa=0&ll=-32.736462,18.091049&spn=0.144396,0.22007&t=h&z=12&msid=111485959450724205753.000480f6eaac2e082741d
http://maps.google.co.uk/maps/ms?hl=en&ie=UTF8&msa=0&ll=-32.736462,18.091049&spn=0.144396,0.22007&t=h&z=12&msid=111485959450724205753.000480f6eaac2e082741d
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Port Owen Marina
Port Owen is a marina /housing development 3.5 miles up the Berg River. Yachts with a draught of 2 metres 
can enter the marina on a spring tide.

Approach
The Berg River has a bar across the entrance that can break in a NW gale; entrance should not be attempted in 
these conditions (anchor at Sandy Point). The bar has a depth of 1.5 metres and, depending on your draught, 
it is probably prudent to enter the river after half tide. If waiting for the tide an anchorage can be found off 
the beach, NE of the entrance in 3 metres.

The Berg river mouth has breakwaters/training walls either side and is dredged to a depth of 3 metres as 
far as the fishing jetties. From there to the holding jetty (the last jetty before the marsh) there is a depth of 2 
metres. From the holding jetty to the entrance to the marina there is a buoyed channel navigable either side 
of high water. Pass close either side of the buoys. Enter the marina using the leading marks on the west bank 
of the river and be aware of the cross current.

The Marina has a few alongside berths, but the majority are bow/stern to the jetty, between posts. Some 
berths are suitable for multihulls. Water and electricity is available on the jetties. In 2008 the charges for a 10 
metres yacht were R45 a day or R450 a month.

Formalities
See Saldanha for formalities as it is in the same customs area.

Facilities
The Port Owen Yacht Club (which is not part of the marina) is very friendly and welcomes visitors. Toilets, 
hot showers and a washing machine/drying space are available for R15 a day/person or R150 a month. The 
marina has no toilet/shower facilities.

Port Owen Boatyard has a 12-ton crane (which can handle multihulls) and a limited amount of hard 
standing. Mechanical, electrical and general repairs can be arranged through local contractors.

The nearby villages of Laaiplek and Veldriff have several supermarkets, hardware stores and petrol stations. 
Mini buses run into Vredenburg several times a day. Car hire available in Vredenburg and will probably deliver 
a car to Port Owen.  
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4.		  LAMBERTS BAY      32 05’S    18 18’E
Charts        			   SAN SC3     BA 2091  (inset)

Tides          			   HW springs @ 0400 approx. height 1.4 metres
                   			   HW neaps    @ 10.30 approx height 1.4 metres

Lights         			   East Breakwater Light  Fl 2s W 14metres 13nm  32 05.1’S 18 18.3’E

Magnetic Variation   	 22 30’W (2009)                  

General
Lamberts Bay is a small west coast fishing town, with tourism becoming an increasingly important part of it’s 
economy.

Approach
From the south keep outside the 10-metre line to clear the reefs west of Penguin Island and the Koppies 
rock north of the island. Head for the end of the breakwater when it bears SE. From the north pass west of 
Fisherman’s Ledge and head for the end of the breakwater when it bears SE.

Anchorage
The inner harbour has no room for yachts. The outer harbour, behind the breakwater is filled with diamond 
diving boats on moorings. The only room to anchor is N or NE of the Random Mole, in about 6 metres, clear 
of the channel into the inner harbour. This berth gives good shelter from all but the NW quadrant, but it can 
be rolly. With strong W to N winds this berth would be untenable. Land either on the beach at the foot of the 
Random Mole or at the slipway close west of it.

Facilities
Normal facilities of a small town; a Spar supermarket is on the road by the Random Mole. Slipway, crane and 
repair facilities associated with a fishing harbour. Bus to Cape Town. 

http://maps.google.co.uk/maps/ms?hl=en&ie=UTF8&msa=0&ll=-32.087229,18.306785&spn=0.01818,0.027509&t=h&z=15&msid=111485959450724205753.000480f6eaac2e082741d
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Random Mole Lamberts Bay

http://maps.google.co.uk/maps/ms?hl=en&ie=UTF8&msa=0&ll=-32.087229,18.306785&spn=0.01818,0.027509&t=h&z=15&msid=111485959450724205753.000480f6eaac2e082741d
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5.		  PORT NOLOTH      29 15’S  16 52’E
Charts                             	 SAN 1003A, 113

Tides                              	 HW springs @ 10.30 approx. height 1.5 metres
                                        	 HW neaps   @  16.30 approx. height 0.6 metres

Lights                             	 Port Noloth Rear Fl (3+1) W 17metres 19nm
                                        	 29 15’S  16 52.2’E  
                                        	 Port Noloth front F W/R 2 metrers 5nm
                                        	 29 15’S   16 52.1’E
 
Magnetic Variation   	 22 deg W (2009)

General
Port Noloth is a natural harbour formed by off lying reefs. Diamond diving vessels use it extensively and 
consequently security is strict. This is not a port of entry or exit for South Africa and if you are not cleared in 
or have cleared out this should only be an emergency stop.

Approach and Entry
Approach outside the 30 metre line and head in to cross the bar using the range marks on the shore, which 
lead you between the north and south blinders. The leading bearing is 066 deg., note that the front light 
changes from white to red on closing the bar. In a heavy swell the whole of the bar breaks and entry should 
not be attempted. Once over the bar and past the north cardinal buoy head for the buoyed channel that leads 
to the jetty. 

Berth
The whole of the inner harbour is taken up with diamond boat moorings leaving no room to anchor. It is 
advisable to call harbour control on the VHF (manned 24 hours) and they will allocate a berth (usually tied 
astern of a large diamond boat, because of the sea continually breaking over the reef there is a constant north 
going current through the anchorage, keeping the vessels clear of each other).

Formalities
Call the harbour control on VHF, if not contacted they will come out to see you. Unless cleared into South 
Africa you will not be allowed to land. In an emergency some accommodation can be made.

Facilities
Port Noloth is a fairly remote town but has basic supplies. Emergency repairs can probably be arranged.                         

http://maps.google.co.uk/maps/ms?hl=en&ie=UTF8&msa=0&ll=-29.253006,16.857362&spn=0.018721,0.027509&t=h&z=15&msid=111485959450724205753.000480f6eaac2e082741d
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Port Noloth Town				                 Moorings

Jetty

http://maps.google.co.uk/maps/ms?hl=en&ie=UTF8&msa=0&ll=-29.253006,16.857362&spn=0.018721,0.027509&t=h&z=15&msid=111485959450724205753.000480f6eaac2e082741d
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South West Africa
(Google Terms and Conditions Apply)

Dassen Island					                  Saladanha Bay

Helena Bay					                  Lamberts Bay

Port Noloth						      Zoom east to Inland SW Africa

http://maps.google.co.uk/maps/ms?hl=en&ie=UTF8&msa=0&ll=-29.253006,16.857362&spn=0.018721,0.027509&t=h&z=15&msid=111485959450724205753.000480f6eaac2e082741d
http://maps.google.co.uk/maps/ms?hl=en&ie=UTF8&msa=0&ll=-32.087229,18.306785&spn=0.01818,0.027509&t=h&z=15&msid=111485959450724205753.000480f6eaac2e082741d
http://maps.google.co.uk/maps/ms?hl=en&ie=UTF8&msa=0&ll=-32.736462,18.091049&spn=0.144396,0.22007&t=h&z=12&msid=111485959450724205753.000480f6eaac2e082741d
http://maps.google.co.uk/maps/ms?hl=en&ie=UTF8&msa=0&ll=-33.042918,17.946167&spn=0.143897,0.22007&t=h&z=12&msid=111485959450724205753.000480f6eaac2e082741d
http://maps.google.co.uk/maps/ms?hl=en&ie=UTF8&msa=0&ll=-33.418475,18.085556&spn=0.03582,0.055017&t=h&z=14&msid=111485959450724205753.000480f6eaac2e082741d
http://maps.google.co.uk/maps/ms?hl=en&ie=UTF8&msa=0&ll=-33.418475,18.085556&spn=0.03582,0.055017&t=h&z=14&msid=111485959450724205753.000480f6eaac2e082741d
http://maps.google.co.uk/maps/ms?hl=en&ie=UTF8&msa=0&ll=-33.042918,17.946167&spn=0.143897,0.22007&t=h&z=12&msid=111485959450724205753.000480f6eaac2e082741d
http://maps.google.co.uk/maps/ms?hl=en&ie=UTF8&msa=0&ll=-32.736462,18.091049&spn=0.144396,0.22007&t=h&z=12&msid=111485959450724205753.000480f6eaac2e082741d
http://maps.google.co.uk/maps/ms?hl=en&ie=UTF8&msa=0&ll=-32.087229,18.306785&spn=0.01818,0.027509&t=h&z=15&msid=111485959450724205753.000480f6eaac2e082741d
http://maps.google.co.uk/maps/ms?hl=en&ie=UTF8&msa=0&ll=-29.253006,16.857362&spn=0.018721,0.027509&t=h&z=15&msid=111485959450724205753.000480f6eaac2e082741d
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Namibia
(Google Terms and Conditions Apply)

Luderitz				                               Boat Bay

Ichabo Island					      Hottentot Bay

Walvis Bay					                  Zoom to Walvis Anchorage

http://maps.google.co.uk/maps/ms?oe=UTF-8&hl=en&ie=UTF8&t=h&msa=0&msid=111485959450724205753.000480f6eaac2e082741d&ll=-22.928358,14.502296&spn=0.16379,0.22007&z=12
http://maps.google.co.uk/maps/ms?hl=en&ie=UTF8&msa=0&ll=-26.128778,14.953766&spn=0.077059,0.110035&t=h&z=13&msid=111485959450724205753.000480f6eaac2e082741d
http://maps.google.co.uk/maps/ms?hl=en&ie=UTF8&msa=0&ll=-26.28901,14.938445&spn=0.009619,0.013754&t=h&z=16&msid=111485959450724205753.000480f6eaac2e082741d
http://maps.google.co.uk/maps/ms?hl=en&ie=UTF8&msa=0&ll=-26.447982,15.112553&spn=0.038424,0.055017&t=h&z=14&msid=111485959450724205753.000480f6eaac2e082741d
http://maps.google.co.uk/maps/ms?hl=en&ie=UTF8&msa=0&ll=-26.633649,15.139847&spn=0.153447,0.22007&t=h&z=12&msid=111485959450724205753.000480f6eaac2e082741d
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6.		  LUDERITZ   26 38’S   15 09.5”E
Charts                 		  SAN 110, 1002A &B     INT 2631				     

Tides                  		  HW springs @  23.00 approx.    height 1.2 metres
                           		  HW neaps    @ 04.30 approx.     height 0.6 metres

Lights                 		  Diaz Point Lt   Fl (1) W 10s  53metres  22nm, F  W/R 50metres 3nm
                           		  26 38’S  15 05.6’E
                           		  Shark Island Lt  Fl 1 G/W/R  10s 35metres  8nm                          
                           		  26 38.1’S  15 09.2’E

Magnetic Variation     	 20 deg. W (2009)

General
Luderitz is the first port of entry if sailing north from South Africa. The coast south of Luderitz is a restricted 
diamond mining area. Luderitz is the second port of Namibia after Walvis Bay.

Approach and entry
From the south keep outside the 30 metre line to clear Halifax Reef and once Dias Point bears SSE then 
head to pass N of the N Cardinal buoy (26 36.9’S  15 07.5’E), off Angra Point. Then steer 120 deg to pass 
between the buoys off Penguin Island and Shark Island into Robert Harbour (there are leading marks on the 
eastern shore). Then turn south and head into the buoyed channel into Menai Creek. Call harbour control 
on VHF channel 16 before entering Robert Harbour to be advised of shipping movements, this is particularly 
important in poor visibility 

Fog and poor visibility are common on this coast.

Anchorage
To the east of the buoyed dredged channel in Menai Creek are moorings for lighters and fishing boats. At the 
south end of these are yacht moorings, one of which may be vacant (enquire at the yacht club to find out if 
it can be used). Otherwise anchor as convenient near the moorings, clear of the channel, in about 3 metres. 
Several yachts have had problems setting their anchors, but once set the holding is good (and it needs to be). 
If anchoring in moderate winds make sure that the anchor has dug in properly before leaving the vessel as the 
wind can get up quickly and blow very strongly. Land at the floating dock or at the Yacht Club next to it.

Formalities
If entering Namibia call at Immigration and Customs, situated a short way west of the Yacht Club.

Facilities
Luderitz Yacht Club makes visitors welcome. There is a small daily charge to use the facilities of a bar, hot 
showers and water is available. All normal services provided by a small town.

Tourist information and Internet access close by the yacht club.
Air and bus connections to the rest of Namibia and South Africa and there are several car hire 

companies.

http://maps.google.co.uk/maps/ms?hl=en&ie=UTF8&msa=0&ll=-26.633649,15.139847&spn=0.153447,0.22007&t=h&z=12&msid=111485959450724205753.000480f6eaac2e082741d
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Luderitz Approaches
Luderitz Moorings

Menai Creek Lueritz

Shark Island (Penguin Island beyond)

Luderitz Town and Harbour

http://maps.google.co.uk/maps/ms?hl=en&ie=UTF8&msa=0&ll=-26.633649,15.139847&spn=0.153447,0.22007&t=h&z=12&msid=111485959450724205753.000480f6eaac2e082741d
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7.		  BOAT BAY   26 27’S   15 07’E
										           
Charts          		  SAN 110

Tides             		 HW springs @ 10.30 approx.  height 1.5 metres
                      		 HW neaps   @ 04.30 approx.   height 0.6 metres

Magnetic Variation  	20 deg. W (2009)

General
Boat Bay is 11 miles north of Luderitz and provides good shelter from the north through east to south. The 
east side of the bay has some impressive sand dunes.

Approach
The approach is straightforward; take care to avoid the unmarked wreck shown on the chart (26 27.24’S  15 
07.18’E).

Anchorage
Anchor in 7 to 8 metres NNW of the wreck position in sand. Good shelter from the south and east. No 
facilities ashore. 

http://maps.google.co.uk/maps/ms?hl=en&ie=UTF8&msa=0&ll=-26.447982,15.112553&spn=0.038424,0.055017&t=h&z=14&msid=111485959450724205753.000480f6eaac2e082741d
http://maps.google.co.uk/maps/ms?hl=en&ie=UTF8&msa=0&ll=-26.447982,15.112553&spn=0.038424,0.055017&t=h&z=14&msid=111485959450724205753.000480f6eaac2e082741d
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8.	 ICHABO ISLAND   26 17.4’S   14 56.5’

General
Ichabo Island lies 20 miles north of Luderitz. It is one of the old guano islands and is now a bird sanctuary, 
although a very limited amount of guano is still mined. Three nature conservation officials man the island. A 
permit is required to land here, but a call to the island, on VHF, will likely provide an invitation to visit ashore, 
which is well worthwhile.

Approach
From the south give the rocks off the southern shore of the island a good berth. From the north avoid the reef 
that runs, for approximately 3 cables, NNW of the island.

Anchorage
Anchor in about 9 or 10 metres off the jetty, to the east of the island. The anchorage here is not particularly 
sheltered and should only be used in moderate winds. The nearest good anchorages in the prevailing SE 
winds Boat Bay to the south (10 miles) and Hottentot Bay to the north (11 miles).

http://maps.google.co.uk/maps/ms?hl=en&ie=UTF8&msa=0&ll=-26.28901,14.938445&spn=0.009619,0.013754&t=h&z=16&msid=111485959450724205753.000480f6eaac2e082741d
http://maps.google.co.uk/maps/ms?hl=en&ie=UTF8&msa=0&ll=-26.28901,14.938445&spn=0.009619,0.013754&t=h&z=16&msid=111485959450724205753.000480f6eaac2e082741d
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Ichabo Island
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9.		  HOTTENTOT BAY       26 08’S 14 57’E       

General
Hottentot Bay provides good shelter from the E to SW. It is wide open to the NW and recently a diamond 
diving boat dragged ashore here with a sudden wind shift to the NW.

Approach
From the south keep outside the 30metre line to avoid the Gallovidia Reef which extends west and south of 
Hottentot Point.  When Hottentot Point bears east then head into the bay.

Anchorage
Anchor NW of the headland in 7 metres, good holding or further into the bay. No facilities ashore.

http://maps.google.co.uk/maps/ms?hl=en&ie=UTF8&msa=0&ll=-26.128778,14.953766&spn=0.077059,0.110035&t=h&z=13&msid=111485959450724205753.000480f6eaac2e082741d
http://maps.google.co.uk/maps/ms?hl=en&ie=UTF8&msa=0&ll=-26.128778,14.953766&spn=0.077059,0.110035&t=h&z=13&msid=111485959450724205753.000480f6eaac2e082741d
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10.	 WALVIS BAY   22 57’S 14 28.6’E    
Charts                     	 SAN 107, 1001     BA1806, 629 				     

Tides                      	  HW springs @ 23.00 approx.  Height 1.3 metres
                                	 HW neaps   @ 04.30 approx.   Height 0.6 metres

Lights                      	 Pelican Point Lt Fl (3) W 10s 35metres 22nm
                                 	 22 53.5’S  14 26.2’E

Magnetic Variation  	18 35’W (2009) 

General
Walvis bay is a major port for both Namibia and South Africa, which also has a sizable fishing fleet. The bay is 
a natural harbour giving good shelter from all but northerly winds.

Approach
If approaching from the south keep outside the 50 metre line to avoid a dangerous wreck 8 miles south of 
Pelican Point. From offshore pass north of the N cardinal buoy off Pelican Point. Then head to pass E of the 
fish farms before heading south to the moorings off the Yacht Club. There are usually many ships anchored in 
the bay and visibility is often poor.

Anchorage 
Anchor near the yacht club moorings in 3 metres, well out from the yacht club. Several yachts have had 
problems setting their anchors here, but once in the holding is good. There may be a vacant mooring available, 
enquire at the club. Land at the beach in front of the yacht club.

Formalities
Immigration and customs offices are just outside the main harbour gates, near the centre of town.

Facilities
The Walvis Bay yacht club makes visitors very welcome with a bar, restaurant, hot showers and a water tap 
(ask to be shown the potable water tap as there is a tap used only to water the garden).
The town centre is about 3 Kms. from the yacht club. There are Shoprite and Pick and Pay supermarkets in 
town with prices similar to South Africa.

Communications
Air and Bus links to the rest of Namibia and South Africa. Several car hire companies, the most convenient 
being an agency at the Pelican Point Hotel, just across the road from the yacht club.   

http://maps.google.co.uk/maps/ms?oe=UTF-8&hl=en&ie=UTF8&t=h&msa=0&msid=111485959450724205753.000480f6eaac2e082741d&ll=-22.928358,14.502296&spn=0.16379,0.22007&z=12
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Walvis Bay Yacht Club				                 Tourist Boat With Pelicans

Walvis Bay Panoramic

http://maps.google.co.uk/maps/ms?oe=UTF-8&hl=en&ie=UTF8&t=h&msa=0&msid=111485959450724205753.000480f6eaac2e082741d&ll=-22.928358,14.502296&spn=0.16379,0.22007&z=12
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Additional Note to ‘South West Africa’
www.rccpf.org.uk provide Passage Planning Guide SA1 which covers passage planning for the routes from 
Cape Town to Brazil and the Caribbean.

The RCC Pilotage Foundation is grateful to Walter Kleiner who has provided the following notes (Feb 10) 
about routing north from Cape Town.

Information on weather, HF-nets, cruising strategies for South Africa:  http://www.cruisingconnections.
co.za/

South Africa
Leaving Cape Town one can use the frequent (in the southern summer) SE-winds, around Cape of Good Hope 
and Table Bay disturbances and acceleration can be expected, but after passing Robben Island NW of Cape 
Town the SE gets pretty straight in the 20+kn range. It will become less once one reaches the latitude of 
Saldanha  N of it. As the water is cold (the Benguela Currant brings cold water from the high latitudes and sets 
NNW parallel to the coast))and the summer heats the  South African landmass, dense fog is quite usual, less 
dense if  you keep a good distance to the coastline. There is a chance of avoiding the fog if you sail very close 
to the coast, but we don´t feel comfortable doing it. 

Saldanha (33°05’S  17°E 54’E) is a cruising ground for yachts from Cape Town, so it is quite frequented in 
summer and has a yacht club and mooring facilities, but maybe for a foreign yacht it is not as interesting as 
the Cape Town area. 

Namibia
As most of the Namibian coast is somehow restricted area  (“Sperrgebiet”) and related to diamond diving and 
digging, it is prudent to stay a bit offshore. Cape Town to Lüderitz is about 490nm.

The southerly wind accelerates in the approach of Lüderitz  (26°27`S  15°04’E), which is the first port 
in Namibia. One should give the headlands a good clearance and then identify the buoy N of Angra Rock. 
The first two bays are used by surfers for speed records, so be prepared for strong winds. Keeping Penguin 
Island to port one can enter the inner harbor. Contact port control vhf 16 and most probably proceed to the 
smaller commercial jetty for clearance. You will have to pay a mooring fee, even for short term. We found the 
fishermen, diamond divers and the (few) local yachts to be very friendly and helpful. The yacht club is a more 
into socializing than sailing, one can get a good beer, biltong and some advice. Shops, hardware store, usual 
facilities. Fuel by jerry cans, better to fuel up in Cape Town or Walvis Bay. Water at the commercial jetty (fee) 
or by jerry cans from the yacht club. Due to strong winds coming from the desert you can expect to have a lot 
of sand on the boat – cover your sails.

Lüderitz is relaxed, sleepy and nice, some old colonial german buildings, Kolmannskoppe, a deserted 
diamond digger town in the middle of the desert (ca 15km from Lüderitz) can be visited with local tours. 

After leaving Lüderitz one can sail straight to Walvis Bay (22°51’S  14°26’E). The whole “Skeleton Coast “ 
coastline is not well charted, belongs to the “Sperrgebiet” and is therefore off limits.  Locals sailing between 
Lüderitz and Walvis Bay do stop at some bays on the way and comment that there is nothing whatsoever, just 
sand dunes, bleached seal and whale bones and the odd brown desert fox. One is not allowed to go ashore 
and there can be security wardens patrolling the area.  As mentioned above the coastline is not charted, so 
it is prudent to talk to the locals in Lüderitz where to go. Sail into the bays with an eye on the echo sounder. 
All bays are open to the NW.

Coming into Walvis Bay is easy once you have identified the buoy N of Pelican point. Keep it to stb as 
the sands off Pelican Point are shifting constantly, head for the inner approach of Walvis Bay harbour and 
proceed parallel to the quays in a SW direction. The yacht club is a bit SW of the container terminal and 
identified by moored boats, the closer to the club the shallower it gets.  Water by jerry can, fuel in the small 
craft harbour, clearance in the commercial harbour complex (15 min. walk from the yacht club to the main 
gate). Supermarkets, good german bakery,the town is relaxed but not very pretty. Although the anchorage at 
the yacht club is very open it is safe. You might be able to get a private mooring, otherwise anchor, holding is 
very good in mud/sand. There is extensive mineral-salt digging in the lagoon S of Walvis Bay and the mud is 
known to be corrosive. This is unlikely to severely affect chain and anchor during the few visiting days. Good 

http://www.cruisingconnections.co.za/
http://www.cruisingconnections.co.za/
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bar at the yacht club.
If possible one should visit the charming colonial Swakopmund, the desert E of it (hire a 4WD or go on an 

organized tour), which can be done in a day, if you don´t want to leave your boat for a longer period. If going 
to St. Helena stock up as much as you can.

Namibia to St. Helena
It is normally a straightforward passage, about 1230nm. It pays to keep an eye on the weather to keep the 
wind;  as you are a bit north  you have a chance of a slightly better angle than coming directly from Cape 
Town. 

St. Helena (15°55’S   5°43.5W)
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HOW TO USE THIS DOCUMENT (1)

Default Document Display Format

This document will open, by default, with the “Two-up” page display, and with the Bookmarks panel 
automatically showing. Note : the cover page will be displayed on its own to accurately reflect the reading 
experience were you to be reading the actual physical document.

Navigation Panel Options

Page Navigation Panel
Simply click on the Navigation Panel icon, then click on the required page thumbnail.
To hide the Page Navigation, simply click on the Pages icon once again.

To adjust the way navigation pages are displayed, click on the options icon to display options.

Bookmarks Panel
Simply click on the Bookmarks Panel icon, then click on the required bookmark
To hide the bookmarks, simply click on the bookmark icon once again.

To adjust the way bookmarks are displayed, click on the options icon to display options.

Page Display Options 

Changing the way the document is displayed
You can use the following page layouts when viewing this document using  View > Page Display :
Single Page : Displays one page at a time, with no portion on other pages visible
Single Page Continuous : Displays pages in a continuous vertical column that is one page wide
Two-up : Displays each two-page spread with no portion of other pages visible
Two-up Continuous : Displays facing pages side by side in a contuous vertical column

To display the first page of a multi-page document alone on the 
right side, firstly specify the Two-up or Two-up Continuous option. 
Then choose View > Page Display > Show Cover Page During Two-up



31

HOW TO USE THIS DOCUMENT (2)

Next Page

Go to the next Page
Moving to the next page can be achieved by any of the following :
Press the Page Down key
Click on the next page icon
Enter the required page number in the input box
Click on the Document bar along the right handside of the screen.

Zooming into a page
If you wish to see a page in greater detail, you can use the percentage drop-down icon in the main toolbar.  
This provides a number of default zoom-level options.

Once zoomed in, to move the document, hold the left-hand mouse button. Your cursor will change to a 
clenched fist. This will allow you to drag the document to the right position.

Opening and Closing “Reading Mode”
The reading mode hides everything in the page display except the document itself and the menu bar.
Choose View > Reading Mode
Choose Reading Mode again restores the previous view, with the same navigation displays and toolbar 
displays.

Automatic scrolling through the document
To automatically scroll through a document, choose View > Automatic Scroll
Press the Esc key to stop the scrolling

View the document in “Full screen mode”
In Full Screen Mode, the document pages fill the entire screen
View > Full Screen Mode
To go to the next page, press Enter, Page Down, or Right Arrow key, or click the next page icon

Also try CTL 2 and 3 and 0 for different presentations.

Setting PDF Document Display Preferences
You can set your preferences for reading PDF documents by going to :
Edit > Preferences
In particular set :
Edit > preferences > Full Screen and check the “Show Navigation Bar” option
Edit > preferences > Page Display and set your preferred Default Layout and Zoom options

Changing the Toolbar icon options
To add or remove icons from the toolbar, choose Tools > Customise Toolbars

Interactive Table of Contents
This document has been prepared with an interactive Table of Contents. Simply click on the section of the 
document that you wish to view.

Hyperlinks
Where the document contains a reference to an external website, the link will be active and by clicking on 
it, will open your web brwoser on that page (assuming you have access to the internet).

Interactive Photographs
Some photographs in the document are interactive in that by positioning your mouse over the photograph, 
it will be displayed in a bigger format to allow easier viewing. Interactive photographs can be recognised in 
that they have a red frame around them.
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HOW TO USE THIS DOCUMENT (3)

Searching the document for specific words

The document has a full text search capability allowing you to find any specific word in the document. Simply 
enter the required word into the “Find” box in the toolbar and press enter.

If the word occurs more than once, the next word icon is displayed. Just click to go to the next occurence of 
the word.

Adding comments & sticky notes to your PDF document

This document has been prepared so that you can add your own comments and notes to the document.
First open up the Comment & markup Toolbar : Tools > Customise Toolbars
Under Commennt and Markup Toolbar, click “Sticky Note” 
Use the various tools to annotate your document. These include sticky notes, lines, arrows, etc.

Before closing the document, you will be presented with the option to Save your changes to the document. 
Answer “yes” to retain your comments.

To view all comments added in the document, click on the Comments icon (on lower lefthand side of 
screen).

Sending a copy of your comments to RCCPF
To send a copy of all your comments to RCCPF then open up the Comments Panel using the comments 
icon.

Then click on the options icon.

Then select the “Export Selected Comments...” option. This will prompt you to save a file (with a .fdf file 
extension).
You then need to e-mail this file to RCCPF indicating to which RCCPF ebook they refer. Send the e-mail to 
feedback@rccpf.demon.co.uk

Google maps Links
On the header of each section, there is an active link to the appropriate map, courtesy of Google Maps. Just 
click on the pin to access the appropriate map. On accessing the map, select the location,
then select the “zoom to” option.  The use of “more” at the top of the map offers a 
photo option these should be on every map.

Printing the document
This document can be prepared to allow you to print all, or a subset, of the pages.
File > Print...
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FEEDBACK TO THE RCC PILOTAGE FOUNDATION

Send your feedback, comments or suggestions by using the main feedback form on the RCCPF website :

Click here             RCC Pilotage Foundation Feedback

Or send your feedback to :
feedback@rccpf.demon.co.uk

Or mail to the registered address at :

RCCPF
Armaside
Lorton
Cockermouth
Cumbria
CA13 9TL

If you wish to send a copy of the various comments you may have annotated on your copy of this book, then 
this can achieved relatively easily. See the “Sending a copy of your comments to RCCPF” instructions on the 
opposite page.

Mid-season Updates

To access the very latest information, and updates to this document, go to :

Click here             To access the very latest  information, and updates to this document, IF ANY, click here

http://www.rccpf.org.uk/feedback/feedback.htm
http://www.rccpf.org.uk/pf_info/new.htm
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